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1  Release notes for AVT SmartView 1.5.1 

Release version of executable: 1.5.1 
Release date of executable: 11.08.2006 
Minimum Driver/FireStack version: 1.2.0.1/1.2.0.0 
Recommended Driver/FireStack version: 2.3.0.14/2.3.0.1 

1.1 Changes from SmartView 1.5 to 1.5.1 

• Allow to change the order of the Bayer pattern during integration 

• Slightly changed the display of the stated image errors. If “Extras->Drop faulty frames” is 
disabled, the number of erraneous frames is now displayed in-between parentheses. 

1.2 Solved bugs and flaws 

• When reloading settings from an XML setting file for color Marlins and Oscars, there was a 
fatal bug. Solved. 

• On camera settings tab “Format”, the check box for automatic packet size was not always 
reset when changing mode or speed. Solved. 

• Corrected the ranges for the adjustment of the Pikes´ channel balance. 
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2 Release history 

2.1 Release notes for AVT SmartView 1.5 

Release version of executable: 1.5 
Release date of executable: 27.06.2006 
Part of: AVT FirePackage 2.5 
Minimum Driver/FireStack version: 1.2.0.1/1.2.0.0 
Recommended Driver/FireStack version: 2.3.0.11/2.3.0.1 

2.1.1 Changes from SmartView 1.4 to 1.5 

2.1.1.1 Update via FireWire for Guppy and Pike 

You now have the possibility to update your Guppy or Pike firmware without having to connect a 
different cable to your camera than the FireWire cable. 
If Guppy and Pike cameras are selected in the topology view of SmartView, an option “Update 
firmware” is available via normal menu or popup menu -- but only if no viewer window for this 
camera has been opened, so be sure to close it in order to update your firmware. 
The Firmware update dialog allows for two major actions: updating the camera with an accessible 
firmware file provided to you by AVT’s support on one hand, and on the other hand recalling the 
last firmware. 

• Upload: First click the ellipsis button (…) to select a firmware file for your camera. You are 
only allowed to select files with a short version of the camera name in the file name (like 
“PF032C”), so that you can’t select a wrong file by accident. Having selected the file, it is 
scanned for correct contents, rejecting the file if its contents are not suited for the current 
camera. If the file contains a valid firmware set, the “Upload” button becomes active. After 
clicking it, the firmware found in the file is uploaded to the camera, while a progress dialog 
is displayed. After this, a short success message is displayed, and then the camera is reset to 
start the new firmware. 

• Recall recent firmware: If you wish to revert to a previously used firmware set (which has a 
different version number than the one currently used), you may do this by clicking “Recall 
recent firmware”. The passive firmware set is then selected as the new startup set, and the 
camera is reset to start the other firmware. If by chance you have programmed the same 
firmware multiple times, you still have the possibility of programming the original firmware 
which you may get through AVT’s technical support. 

2.1.1.2 Changes for the Pike 

2.1.1.2.1 Modifying the color correction of your camera 

With the Pike, a popular feature is now provided: The color correction, which has been firmware-
defined up to now, can now be user-defined. 
Just to remind you: the color correction is realized as an additional step in the process from the 
sensor data to color output, and it was used to harmonize colors for the human eye. With other 
AVT (color) cameras so far, you had the opportunity to use it or to switch it off. Now, you may 
manipulate the color-correction coefficients yourself. This may be done on camera settings tab 
“Ctrl 3”. There, you see a three by three matrix containing values from -1000 to +2000. 
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Some notes:  

• For an identity matrix (leaving the colors as they are in the RAW modes), values of 1000 
should be set for the diagonal elements, and 0 for all others.  

• The sums of all rows should be equal to each other; otherwise you will get tinted images. 

• Each row should sum up to 1000; otherwise, images will become less or more colorful. 
For more information, please contact our technical support. 

2.1.1.2.2 Modifying the channel balance of the Pikes’ image sensors 

To achieve more speed, the Kodak sensors of the Pikes are read out horizontally via two separate 
channels, so two ADCs are involved which may have to be configured differently. A standard 
adjustment between the channels is done at production time, but under certain circumstances, an 
intensity step might still be visible from left to right. To be able to make the step disappear, 
there is an extra dialog available from the viewer window. Either use menu item Extras->Adjust 
channels or press Alt+Ctrl+A. For using this dialog, the camera must be in format 7 and in RAW 
(color cameras) or MONO (monochrome cameras) modes. If you are using RAW modes, make sure 
not to use the viewer debayering because the pure sensor data is needed. 
Using a pattern that has the full range of intensity values along a vertical line in the middle of 
the image, start image capturing and either select the channel adjustment value manually (by 
slider or by value) or press the “Do one-push adjustment” button, possibly multiple times. 
The final value will only be active as long as the camera is powered and may be stored (among 
others) in user sets. (The original value may always be retrieved when loading factory set 0). 

2.1.1.2.3 Saving shading data permanently 

With the Pike, you are now able to store your generated shading data in flash memory inside the 
camera, allowing you to calibrate your imaging setup once under controlled conditions and then 
just load the stored shading data with one command after camera startup without having to 
transfer data from the PC to the camera. 
For this, you are now able to switch the external source/destination from “file” (like it was 
possible before) to “flash”, allowing you to store to flash, load from flash and to clear the flash 
instead of downloading and saving shading data to a file or uploading from a file. 

2.1.1.3 Viewer window 

2.1.1.3.1 Zoom keys (Alt+“+”,Alt+”-“) 

In the viewer window, zooming in/out is now invoked by the keys Alt+”+” resp. Alt+”-“, and 
selecting maximum/minimum zoom is done by “Ctrl”+”Alt”+”+” resp. “Ctrl”+”Alt”+”-” (instead of 
“+”, “-“, Ctrl+”+” and Ctrl+”-“). To be able to enter negative numbers, e.g. for the color correction 
coefficients, different keys than “+” and “-“ had to be used. 

2.1.1.3.2 Debayering Hue/Saturation 

The “extra features during debayering” on “Ctrl 3” tab are now available for every color camera, 
not only for the Guppy (but still only in RAW8 modes with the last three offered debayering 
methods - “2x2 YUV422”, “2x2 LCAA” and “2x2 LCAA+V”). 
Additionally, these three algorithms “2x2 YUV422”, “2x2 LCAA” and “2x2 LCAA+V” have been sped 
up if hue or saturation are used. 
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2.1.2 Solved bugs and flaws 

• Corrected the frame rate displayed on the “Format” tab of the camera settings dialog. Now 
this value should be the same as the maximum transfer rate that can be achieved. Previously, 
it didn’t consider the jitter of half a cycle around the start of the transfer. 

• The debayering pattern was always saved in-between sessions, but was not correctly 
initialized at startup. Fixed. 

• For cameras with more output pins than input pins, the output mode “follow input” is not 
available any more for output pins missing a corresponding input pin (e.g. this mode is 
available for output pin 1 of the Guppy, which corresponds to input pin 1, but not for output 
pins 2 and 3) 

• For the Pike, user sets / memory channel data is much bigger than before, so the time it 
takes to save them to flash memory is much longer. The timeout was much too small. Fixed. 

• For the Marlin 131, the timeout for saving blemish/defect pixel data was also much too small, 
which led to strange camera behavior afterwards. Fixed. 

• Removed the 16 bit debayering method “2x2, inv”, which was meant to be used with 16 bit 
raw data in big endian byte order – which AVT cameras don’t provide.  

2.1.3 Added files 

There are two added LUT files: 

• LUT_Pike_Gamma_040_150.csv 

• LUT_Pike_Contrast.csv 
which provide gamma tables and contrast-manipulating tables for upload to the Pike cameras. 
The first file contains a series of LUTs for the gamma function with a gamma of 0.4 to 1.5, using 
steps of 0.05, the second file contains LUTs lowering or enhancing the contrast in the range of 
0.25 to 4.0. 
All of the LUTs start in row 2 because the first row is a header row. Since the first column is filled 
with the LUT entry index, the look-up table with a gamma value of 0.4 is positioned in the 
second column (Col B), so for a gamma of 0.9, you must select Col L.  
 

2.2 Release notes for AVT SmartView 1.4 

Release version of executable: 1.4 
Release date of executable: 17.02.2006 

2.2.1 Changes from SmartView 1.3. to 1.4. 

2.2.1.1 Behavior 

• There is new default behavior when the viewer window is opened: Using the first image 
normally taken by the automatic one-shot, values for shutter and gain are computed (if they 
would result in an image too light or too dark) and an auto white balance is performed, and 
an additional image is taken, resulting in an image which should look roughly OK. (If settings 
are loaded or free-run is enabled at start, this is of course not done). This behavior may be 
modified by start parameters or by menu entries (disable Camera->Options->”Set shutter, gain 
and white balance automatically”. 

• The default behavior of making a one-shot may now also be changed via menu entry (disable 
Camera->Options->”Start one-shot on camera open”) 
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2.2.1.2 Camera settings window 

• On the “Ctrl 3” tab, the sliders for hue and saturation during debayering have more stops in-
between. 

• On the “Adv 2” tab, the new image stamp may be controlled. An image stamp including the 
cycle counter, the frame counter and the trigger counter may be positioned at the beginning 
of the row that you specify. The row number may either be a positive value up to the number 
of rows in a given image format, counted from the start of the image, or a negative number, 
which counts the rows from the last end of the image, so -1 means the last row. As before 
with the frame counter, now the trigger counter and the frame counter are only polled if the 
display check box is activated. 

• Also on “Adv 2” tab, several camera registers may be saved in a user set inside the camera 
which may be restored by just one click/register toggle – also across sessions. 

• On “Trig/IO” tab, the column “Polarity” for the input/output pins is now called “Invert” to 
clarify the use of this bit. A polarity of “low” before is now read as Invert:no, meaning the 
same. 

• On the “Format” tab, the number of used frame buffers as well as the used debayering is 
stored in-between sessions. 

2.2.1.3 Viewer window 

• The display of frame numbers in the status bar has changed slightly: If there is more than 
one number, not all frames arriving on the card could be processed and displayed. The first 
number now shows the number of frames arriving at the card, the second number shows the 
number of frames lost on driver level (e.g. due to receive FIFO overflows), and the third 
shows the number of frames lost due to poor processing capability. The frame rates shown 
still show the frame rate at the card and, if there is a second frame rate, this one shows the 
processing frame rate. 

• There are new menu entries for configuring the start behavior, available via Camera->Options: 
o Start one-shot on camera open 
o Set shutter, gain and white balance automatically 

• There is a new menu entry for controlling the camera communication. Now,  you can specify 
that you don’t want any asynchronous block transfers by disabling Extras->”Allow async block 
transfers” 

• There is also a new menu entry controlling the output of the Firewire driver: By disabling 
Extras->”Drop faulty frames”, also all frames marked with an error are passed to processing 
and will be displayed. Use this switch if you use 1394b on a very slow computer (usually a 
laptop with a PCMCIA card) and you want all the frames arriving at the driver to be displayed. 

2.2.1.4 Start options 

Additionally to the appropriate menu entry, use start option “–a” for preventing the viewer from 
trying to adjust shutter, gain and white balance automatically after the initial one-shot. This flag 
is only valid if the –o flag is not specified. 

2.2.2 Solved bugs and flaws 

• If there was a bus reset on a 1394 bus where a camera was currently integrating, the DMA 
channels were not freed before re-enumeration, so that the viewer was quickly running out of 
1394 resources. Solved. 
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• The Marlins did not have any support for serial I/O any more. Now they have it again. 

• In the Marlins, the MONO16 mode was reported to have 14-bit depth (the pixel info also 
showed values according to 14 bit). Solved. 

• In the “Format” tab of the settings dialog, the ISO channel number was not written into the 
appropriate register. Solved. 

• After loading settings and after a soft reset, the display size did not fit the current zoom 
factor. Solved. 

• If the specified XML settings file could not be found during an auto-load action, the message 
box popping up could not be closed by clicking OK, but only by closing the message box 
window. 

• After loading settings, the “Auto” payload switch was still in the state as before, independent 
from the loaded payload settings. Now, if the payload is at the maximum, the auto switch is 
disabled, and if it is equal to the maximum, it is enabled. 

• Some minor GUI changes for more user-friendliness. 
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2.3 Release notes for AVT SmartView 1.3 

Release version of executable: 1.3 
Release date of executable: 14.12.2005 

2.3.1 Changes from SmartView 1.2.4. to 1.3. 

2.3.1.1 Behavior 

• Full support for Guppy cameras GF-033B/C, GF-046B/C and GF-080B/C. 

• Initial reading of the camera configuration is now restricted to S100, so that every camera 
may be found, even those that are only available over a slow/unreliable cable. 

• For the initial read operations of the settings, the current camera capabilities are taken into 
consideration, resulting in less read operations and less read errors during startup. 

• More checking for errors during read and write operations on the 1394 bus. 

• As far as window positions are stored between sessions, they are checked for plausibility more 
thoroughly (and corrected) before applying them. 

• Zoom keys (+ and -) have this function only when the viewer window is focussed. If the 
settings dialog has the focus, these keys are directed to dialog controls.  

2.3.1.2 Camera settings window 

• There is a new “Ctrl 3” tab, where you can adjust hue and saturation during debayering 
using methods “2x2 YUV422”(the older Marlin/Dolphin algorithm), “2x2 LCAA” (local color 
anti-aliasing, the method in newer firmware versions) and “2x2 LCAA+V” (local color anti-
aliasing including vertical color smoothing, the newest algorithm for Pike cameras). This 
costs a lot of CPU power, of course, if values different from 0 (hue) or 100 (saturation) are 
selected, so be careful. Details for the algorithms: 

o All three algorithms convert the transported RAW8 image to the YUV space, where 
low-pass filtering of the color information (U and V values) takes place, and a 
conversion to the BGR space (the Windows RGB) afterwards. 

o Color low-pass filtering: “2x2 YUV422” only uses two horizontally neighboring 
pixels, “2x2 LCAA” uses four horizontally neighboring pixels and “2x2 LCAA+V” uses 
a window of four horizontal and two vertical pixels. 

o If hue is 0 (no hue rotation) and saturation 100 (=100%), a more efficient back 
transformation is performed, otherwise the hue rotation and the saturation 
enhancement are done in the YUV space before the transformation back into the 
RGB space. 

• On the “Format” tab, you may adjust the number of frame buffers used by the FireStack. The 
number of buffers used for processing is 2 less than this number, so that the FireStack always 
has enough frame buffers to keep up DMA transfer. Nevertheless, if the processing buffer is 
full, the next arriving frame is dropped. The default value for the number of buffers is 16, 
with a minimum of four. 

2.3.1.3 Viewer window 

• The maximum size of the viewer window is now restricted to the screen size. 

• The asynchronous transfer speed may be set manually (“Extras” menu) 
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• If logging is enabled, you may enable immediate flushing of the log file, so that every log 
message is written directly to the log file. This may of course slow down the viewer speed, so 
handle with care… 

• There is a new menu entry View->“Reset position of settings dialog”, to be used in case that 
the settings dialog doesn’t reappear. 

• The display of the image rate in the status bar is slightly modified: If reception and 
processing rate are the same, only one value is displayed. (The value does not show the 
absolute value from integration start, but shows a temporally low-pass filtered value of the 
current frame rate, so that abrupt changes don’t occur.) 

2.3.1.4 Topology viewer 

• After selecting a camera, a context menu is available, which allows you to soft-reset a camera 
(if the unlikely case of a complete loss of control over a camera should occur). 

2.3.1.5 Start options 

Use start option –b for preventing all selected cards from becoming bus-master. 

2.3.2 Solved bugs and flaws 

• If there was a bus reset on a 1394 bus where a camera was currently integrating, the DMA 
channels were not freed before re-enumeration, so that the viewer was quickly running out of 
1394 resources. Solved. 

• Some minor GUI changes for more user-friendliness 

2.3.3 Added files 

There are two added LUT files: 

• LUT_Guppy_Gamma_040_150.csv 

• LUT_Guppy_Contrast.csv 
which provide gamma tables and contrast-manipulating tables for upload to the Guppy cameras. 
The first file contains a series of LUTs for the gamma function with a gamma of 0.4 to 1.5, using 
steps of 0.05, the second file contains LUTs lowering or enhancing the contrast in the range of 
0.25 to 4.0. 
All of the LUTs start in row 2 because the first row is a header row. Since the first column is filled 
with the LUT entry index, the look-up table with a gamma value of 0.4 is positioned in the 
second column (Col B), so for a gamma of 0.9, you must select Col L.  
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2.4 Release notes for AVT SmartView 1.2.4 

Release version of executable: 1.2.4 
Release date of executable: 31.08.2005 

2.4.1 Changes since SmartView 1.1.0. 

(In cyan: changes since SmartView 1.2.0) 
(In blue: changes since SmartView 1.2.2) 

2.4.2 Start options 

2.4.2.1 Start only one camera in a viewer window 

If you specify a command line option like “-g17171717”, only one viewer window is opened for 
the camera with the given ID (that you can see on the label on the camera). If the name of a 
valid camera settings file is specified in 
HKEY_CURRENT_USER\Software\AVT\SmartView\Options\SettingsFileName which contains settings 
for the camera in question, the settings are automatically loaded at program start and 
automatically saved at program end, unless you also specify the option “z”. So, to just start a 
viewer window for a specific camera without auto-loading and –saving, use option string           
“-zg17171717”.  

2.4.2.2 Start viewer without initial one-shot 

Specifying command line option “-o” disables the initial one-shot. This comes in handy if the 
camera you want to look at is still in external trigger mode and thus hangs during opening. 

2.4.3 Viewer window 

2.4.3.1 Behavior 

• Recording options: The menu entry “File->Set stream file name…” has been renamed to 
“File->Recording options…”. The functionality has been moved to the dialog that’s 
popping up if you select the menu entry. Also on this dialog, you may set the number of 
digits used to construct the file name (you should set the file name AFTER you changed 
this value), and you may specify that you want only every nth image to be recorded. 

• Keyboard support: The “record” function is now available via “Ctrl+R” 

• Zoom: Set zoom factor to 1 using Alt+”-“ keys and to maximum using Alt+”+” keys 

• Zoom and “auto resize view”: If “View->Auto resize view” is selected, and you zoom in 
or out, the display window is resized if the resulting window size fits into the screen size. 

• Camera settings: There is now an additional possibility to save and load camera settings 
to a file not by GUID like before, but by the camera type (model name + firmware 
number), so that one camera setting is valid for all cameras of the same type. For this, 
disable the menu entry “Camera>Settings>Search for camera by GUID” 

2.4.3.2 Image view 

• Status bar: The meaning of the image counters in the status bar has changed a bit. The 
pane on the left shows the current status or the image resolution, if selected. The next 
pane shown in the middle still displays the number of frames that have arrived on the 
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FireWire bus from isochronous start, followed by the number of processed images instead 
of the number of “dropped frames” in previous versions (no matter who dropped them).  
The first value is always displayed, but the second only appears if frames could not be 
processed. The pane left of the display size shows an approximation of the frame rate on 
the FireWire bus, followed by the rate of processed images if not all images could be 
processed. 

• Histogram window: There is now a minimum size of 256x128 for this window 

2.4.3.3 Camera settings dialog 

•  “LUT/Shading” tab 
- If a LUT has been uploaded into the camera, this LUT may be displayed in a 

separate window with a button on this tab. 

• "Adv 2" tab 
- Local color anti-aliasing: If a camera supports this feature, it can be switched on 

with a checkbox on this tab. 

• Moved the Tool tip check box to an entry in the help menu of the main viewer window. 

2.4.3.4 Window titles 

To keep the captions of the additional windows a bit shorter, the card number and the node 
number added in version 1.1 are now abbreviated to something like “C0,N1”. 
Furthermore, if you specify a registry key “HKEY_CURRENT_USER\Software\AVT\ 
SmartView\CameraView\DisplaySN with a value of 1, the serial number of the camera is displayed 
additionally to the node number in the window captions. This is the same info as on the “Adv 1” 
tab, so this is no additional information, but a shortcut to available information. 

2.4.3.5 Behavior 

• Due to a change in the event signalling by the FireStack, the receiving of image frames had 
to be changed. This might slow down image processing a bit. 

• Improved bus level logging. 

• Reduced the priority of processing thread to “normal”. This way, you have a better chance to 
control the camera on slow systems, but the number of lost frames due to image display may 
increase. Only for continuous saving of images aka streaming, the priority is increased to 
“above normal” 

• Improved stability around image grabbing. 

2.4.4 Solved bugs and flaws 

• After loading camera settings, the contents of the shutter register was sometimes not 
correctly restored. This is now solved. 

• After loading camera settings, the status of the mirror image flag was not correctly shown. 
This is now the case. 

• After switching from Format_7 to non-Format_7 modes on settings “Format” tab, all the 
format 7 related fields are cleared. 

• In version 1.1, a file called “AVT_SmartView.log” was always created. Now, this file is only 
created if an appropriate start option is supplied. The log file is created in the same folder 
as the viewer executable, and it is only flushed every 8000 characters, so you have to 
close the viewer to see the complete log file. The log levels are: (listed in decreasing 
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severity and including all the log levels above them) 
o “-f”: fatal 
o “-e”: error 
o “-w”: warning 
o “-i”: info 

• There was a bug in restoring camera settings from a file for some newer firmware numbers 
which led to different camera settings than specified in the settings file which is now 
solved. 

• Corrected behavior around “auto-resize view” option of the viewer: Now changing the 
format or mode leads to a zoomed display if zoom was enabled. 

• Switching between RAW16 and RAW8 could lead to suppressed image display. Solved. 

• Solved a bug which led to the selection of a too high frame rate when opening a camera 
view. 

• A few minor GUI bug fixes. 

2.4.5 Added files 

There are three more files which contain a lot of look-up tables each, “LUT_Oscar_Contrast.csv”, 
“LUT_Dolphin_Contrast.csv” and “LUT_Marlin_Contrast.csv”. These are LUTs for increasing or 
decreasing the contrast for an image. Each of them has 16 tables with contrast values ranging 
from factor 0.25 to factor 4. A factor of 4 means that the gradient in the middle of the LUT is 
steeper by a factor of 4. 
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2.5 Release notes for AVT SmartView 1.1.0 

Release version of executable: 1.1.0 
Release date of executable: 21.02.2005 

2.5.1 Changes since SmartView 1.0.0 

2.5.1.1 Cameras 

2.5.1.1.1 Full Oscar support 

The whole Oscar family with all of the new features is supported by this SmartView version. 
RAW16 color mode images in Format_7 may now be saved as raw 16-bit files, the pixel values may 
be observed in full resolution and the histogram also may show the full image depth. Depending 
on the High SNR mode, the images may have a depth of up to real 16 bit (12-bit depth is normal 
in RAW16 mode). 

2.5.1.1.2 MF131 support updated 

Along with the release of SmartView 1.1, the Marlin MF131 B and C have received a firmware 
update. To be able to use the DSNU and blemish pixel functionality of this better firmware, this 
viewer is needed. MF131 cameras with an older firmware cannot be controlled by this viewer 
version. 

2.5.1.2 Deep-image support 

It is now possible to use images with more than 8-bit depth if the current camera mode allows it 
(MONO16 and RAW16 color modes). You can enable/disable this support by selecting the 
“File>Use deep images” menu item. The state of this switch is saved when the window is closed. 
During deep-image support, the enhancements are: 

• Extended histogram. Toggling the switch also toggles the display instantaneously 

• Adjusted tooltip pixel values 

• Saving 16-bit images is also possible. The file extension you enter in the “Save as...” 
dialog will only be valid for the 8-bit output. For the 16-bit output, the extension will be 
“raw”. 

• Saving a series of 16-bit images. 
The file format is exactly as it is comes from the camera, i.e. with the higher byte first, and the 
assembled pixel value is MSB-aligned, so that the lower bits are zero.  
Example: a sequence “7F F0 FE 50” of a 12-bit image should be interpreted as “07FF 0FE5”, 
(equals “2047 4069”). 

Warning: If you work with deep images, more computation is necessary and the viewer might 
become slower, leading to dropped frames! 

2.5.1.3 Viewer window 

2.5.1.3.1 Behavior 

• Keyboard support: The cursor keys and the PgUp/PgDown keys have changed their 
meaning from moving the image to moving the scroll bars to be compatible with other 
programs. So now, pressing the right arrow key moves the scrollbar one position to the 
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right and thus the image one position to the left, for example. 

• Additional keyboard support: The SHIFTed cursor keys now move the image position half 
a screen width or height. If in scroll mode, the “Home” key (aka “Pos 1”) centers the 
image to the cursor position (as far as possible). 

• Record function: This function is now also available during free-run. 

2.5.1.3.2 Image view 

• The histogram now displays two additional x-axis values: the maximum value and the 
medium value for orientation. Furthermore, the vertical wobbling of the histogram during 
continuous shot has been decreased a bit. An additional black vertical line in the lower 
regions of the histogram shows the position of the maximum of the histogram. 

2.5.1.4 Camera settings dialog 

•  “Format” tab 
- High SNR mode control: select a value from the combo box to enable the AVT High 

SNR mode. Since the image is transported after the complete computation of the 
added image, the currently achieved frame rates are approximately (the frame rates 
without High SNR mode enabled) divided by (the selected value plus 1). 

- De-bayering methods (RAW8): 
� A mode with UV-low-pass-filtered color output which produces the same 

color output as the Marlins and Dolphins in YUV422 mode (except for the 
color correction) is now included, called “2x2 YUV422”. In this mode, two 
consecutive U or V values are averaged before creating the 4:2:2 byte 
stream. 

� A mode including low-pass-filtering 4 U and V values horizontally (instead 
of 2 bytes, as in the mode above) is also added, called “2x2 Int4UV” 

� A monochrome mode derived from the standard debayering is also added. 
(Only the Y signal is displayed) Name “2x2 mono” 

� The RAW16 mode has still got only one valid 2x2 debayering. 
- The starting debayering pixel can be selected in a separate combo box 
- The channel for isochronous transfer can be selected by an added combo box. An 

additional check box controls the automatic acquiry of a different channel number 
if the selected number fails. In this case, the acquired channel number is displayed 
in the combo box. 

• “Trigger/IO” and “CMOS” tab 
- During HDR mode, level mode trigger is not possible any more and vice versa (due 

to a camera restriction) 
- The multi-shot counter also controls the number of shots in trigger mode 15 

• "CMOS" tab 
- Blemish/DSNU correction: Behavior adapted to current camera functionality. Use 

the current camera firmware; cameras with older firmware cannot not be controlled 
properly 
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2.5.1.5 Direct Access dialog 

2.5.1.5.1 Register name support 

There is an additional combo box containing the name of a register to read or write to. This 
combo box is selected according to the numerical value in the “address” edit field, or a register 
name can be selected directly, and the address field is filled accordingly. 

2.5.1.5.2 Most recent write operations stored 

When closing the viewer, the ten most recently used write accesses will be stored and redisplayed 
in the history panel of the dialog. This allows you to carry on with your work of the previous 
session more easily or allows you easier access to registers that are often used. 

2.5.1.6 Window titles 

The caption of all windows now also contains the card number additionally to the node number, 
so that identical camera types with the same node number on different card may be distinguished 

2.5.2 Solved bugs and flaws 

• Corrected Mono16 and Raw16 support 

• All used registry entries may now be found in HKey_Current_User/Software/AVT/SmartView 

• After reading camera settings, the contents of the combo box containing trigger polarities 
is set to the correct value. 

• In the direct access dialog and the camera settings dialog, the cursor keys work again. 

• Wrong colors in the histogram of RAW8 images were corrected. 
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2.6 Release notes for AVT SmartView 1.0.0 for Intek. 

2.6.1 Release Info 

Release version of executable: 1.0.0 
Release date of executable: 10.01.2005 

2.6.2 Changes since IIDCView 0.5.0. 

2.6.2.1 Viewer window 

2.6.2.1.1 Behavior 

• Error handling: 
o If there’s an error when starting exposure, a message box is displayed. 
o If reading or writing the camera settings produces an error, a message box is 

displayed. 

• Stronger checking for quick settings read/write functionality; reading is only possible 
if the camera is not running, a file name is given and this file exists; writing is only 
possible if the camera is not running and a file name is given. 

• The display state of the display settings dialog is saved when closing the viewer 
window, and restored during start-up, so that it only comes up if it was displayed the last 
time you closed the viewer window. 

2.6.2.1.2 Image view 

• In zoom mode, images are displayed beginning at pixel boundaries. This might be 
irritating when zooming in or out because the pixel below the mouse position seems to 
move (it doesn’t; the mouse stays centered on the same pixel, but the position of the 
pixel on the screen changes) 

• A histogram of the current image can be displayed (menu View->additional information). 
Keyboard shortcut: CTRL+SHIFT+H 

• Full scroll bar functionality: they are also usable for image positioning 

2.6.2.2 Camera settings dialog 

2.6.2.2.1 Changed functionality and usage 

•  “Control” tab 
- One-push white balance changes are also reflected in the sliders 

• “Control 2” tab 
- Autofunction AOI: Width and Height combo boxes only show values accepted by 

the camera 

• "Adv 2" tab 
- Fixed: Software reset changes the settings to the default settings without autoload 

(i.e. the largest fixed mode with the first color mode 

• "CMOS" tab 
- Blemish/DSNU correction: Behavior adapted to current functionality. “Show 

correction data image” disables the “Blemish correction on” and “DSNU correction 
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on” buttons. 
- HDR mode: Additional “easy mode” control. See below 

• “LUT / Shading” tab 
- Added LUT support for Oscar cameras 

2.6.2.2.2 HDR mode control 

• In expert mode, the additional integration times after the reset levels are fully adjustable 

(they are not as restricted as in previous versions). Warning: You can also enter values 
that will not lead to any additional gain or result in a strange characteristic curve. 
Additionally, the minimum and maximum values for the additional gain are displayed 
above the slider and the current additional gain is displayed in the edit box beside the 
slider of the easy mode. 

• In easy mode, the slider controls the desired additional gain (adjusted by the highest 
active reset level) which can be achieved for this shutter time and number of reset levels. 
It also adjusts all lower reset levels and the shutter value automatically so that the 
characteristic curve is as smooth as possible. You can see the resulting values in the value 
fields in the expert mode edit boxes. 

• You can easily switch between the modes. When switching to easy mode, the value of the 
highest activated additional integration time is used as the basis for recalculating the 
values of all of the additional integration times, using the summed-up integration time. 
When switching back to expert mode, all the values are kept as before. 

• “Display graph” gives a presentation of the characteristic curve resulting from the sensor 
reset settings as it will be if the HDR mode is enabled. 

• Recommendations 
- Auto-shutter must be off! 
- Remember that in the original image, there should be many pixels with grey level 

255 (see histogram) 
- Keep the histogram window open 
- Display the characteristics graph 
- Hint: also think of adjusting the “brightness” register value; 
- Keyboard usage for the slider is also possible: select the slider by mouse click, 

afterwards you can use SHIFT+LEFT and SHIFT+RIGHT for positioning the slider. 
- Proposed procedure: 

� Disable HDR mode, select “easy mode” control on “CMOS” tab 
� Display the histogram window 
� Set the extended shutter value on tab “Adv 1” and the brightness register 

value on tab “Ctrl 1”so that the dark image parts look good and the 
histogram also looks good. 

� On the “CMOS” tab, select the number of reset levels, select the lowest 
additional gain that’s possible, enable hdr mode and start the camera. 

� Play with the slider until the histogram and the image look nice in the 
upper grey level regions 

� If needed, switch to expert mode and play some more with the values in 
between the shutter value and the highest reset level to smooth the 
histogram. 
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2.6.2.3 Note for camera settings support 

In order to be able to save and load camera settings to and from an xml configuration file, the 
MSXML parser must be installed on your system.  

2.6.2.4 Additional files 

• Msxml3ger.msi: Installation file for the MSXML parser, version 3 service pack 4, German. 
For information or other languages see the Microsoft home page 

• GdiPlus.dll: This DLL is only needed on Windows 2000 systems, not on Windows XP. For 
information or other languages, see the Microsoft pages 

• CSV tables containing gamma look-up tables to upload to several AVT cameras. All of them 
contain LUTs for the gamma function for a gamma of 0.4 to 1.5, using steps of 0.05. All of 
them start in row 2 because the first row is a header row. The first look-up table with a 
gamma value of 0.4 is positioned in the second column (Col B), so for a gamma of 0.9, 
you must select Col L. Since the three camera families have different bit depths, there are 
three files: 

o LUT_Dolphin_Gamma_040_150.csv 
o LUT_Marlin_Gamma_040_150.csv 
o LUT_Oscar_Gamma_040_150.csv 

 
 


